User Manual for the Dismounted Infantry Virtual After Action Review System (DIVAARS)

Bryan R. Clark
University of Central Florida
Consortium Research Fellows Program

Donald R. Lampton
U.S. Army Research Institute

Glenn A. Martin
University of Central Florida Institute for Simulation and Training

James P. Bliss
Old Dominion University

June 2004

Simulator Systems Research Unit
U.S. Army Research Institute for the Behavioral and Social Sciences

BEST AVAILABLE COPY

Approved for public release; distribution is unlimited.
U.S. Army Research Institute
for the Behavioral and Social Sciences

A Directorate of the U.S. Army Human Resources Command

ZITA M. SIMUTIS
Director

Technical Review by

John S. Barnett, U.S. Army Research Institute
David M. Johnson, U.S. Army Research Institute

NOTICES

DISTRIBUTION: Primary distribution of this Research Product has been made by ARI. Please address correspondence concerning distribution of reports to: U.S. Army Research Institute for the Behavioral and Social Sciences, Attn: DAPE-ARI-PO, 2511 Jefferson Davis Highway, Arlington, VA 22202-3926.

FINAL DISPOSITION: This Research Product may be destroyed when it is no longer needed. Please do not return it to the U.S. Army Research Institute for the Behavioral and Social Sciences.

NOTE: This Research Product is not to be construed as an official Department of the Army position, unless so designated by other authorized documents.
1. REPORT DATE (dd-mm-yy) | 2. REPORT TYPE | 3. DATES COVERED (from...to)


5a. CONTRACT OR GRANT NUMBER | 5b. PROGRAM ELEMENT NUMBER
N/A | 2Q622785A

6. AUTHOR(S)
Bryan R. Clark, (University of Central Florida), Donald R. Lampton, (U.S. Army Research Institute), Glenn A. Martin (University of Central Florida Institute for Simulation and Training), and James P. Bliss (Old Dominion University)

5c. PROJECT NUMBER | 5d. TASK NUMBER | 5e. WORK UNIT NUMBER
A790 | 233 | H01

7. PERFORMING ORGANIZATION NAME(S) AND ADDRESS(ES)
U.S. Army Research Institute for the Behavioral and Social Sciences
ATTN: DAPE-ARI- IF
2511 Jefferson Davis Highway
Arlington, VA 22202-3926

8. PERFORMING ORGANIZATION REPORT NUMBER

9. SPONSORING/MONITORING AGENCY NAME(S) AND ADDRESS(ES)
U.S. Army Research Institute for the Behavioral and Social Sciences
2511 Jefferson Davis Highway
Arlington, VA 22202-3926

10. MONITOR ACRONYM
ARI

11. MONITOR REPORT NUMBER
Research Product 2004-03

12. DISTRIBUTION/AVAILABILITY STATEMENT
Approved for public release; distribution is unlimited.

13. SUPPLEMENTARY NOTES

14. ABSTRACT (Maximum 200 words):
This product includes the operator's manual for the Dismounted Infantry Virtual After Action Review System (DIVAARS). The 16-page manual provides complete instructions for the installation and use of the DIVAARS software. Along with the manual, a description is presented of why and how the manual was developed, including a detailed account of usability testing. Information about obtaining the DIVAARS software is included.
DIVAARS can function as a After Action Review system for any exercise conducted with Distributed Interactive Simulation (DIS) compliant systems. Examples of DIS systems are: the Squad Synthetic Environment (SSE), Virtual Emergency Response Training System (VERTS), and the Fully Immersive Team Training (FITT) system. DIVAARS is especially useful for training small teams that operate on foot (versus from within vehicles) and in urban areas (including operations inside of buildings).
DIVAARS requires a dual Pentium III, 1.0GHz PC (or single equivalent processor, e.g., Pentium 4, 2.0GHz), 512MB RAM, 40GB drive, and a hardware-accelerated video card (e.g. nVidia GeForce 4). DIVAARS runs on Red Hat Linux (version 8.0 or 9). Other software requirements (freeware via World Wide Web) include the Virtual Environment Software Sandbox 3.0.0, Open Scene Graph 0.9.6, and OpenAL.

15. SUBJECT TERMS
military training, after action review, usability testing, Dismounted Infantry Virtual After Action Review System (DIVAARS)

16. REPORT UNCLASSIFIED

17. ABSTRACT | 18. THIS PAGE | 19. LIMITATION OF | 20. NUMBER | 21. RESPONSIBLE PERSON
Unclassified | Unclassified | ABSTRACT | OF PAGES | (Name and Telephone Number)
Unclassified | Unlimited | | | Don Lampton
(407) 384-3989
User Manual for the Dismounted Infantry Virtual After Action Review System (DIVAARS)

Bryan R. Clark
University of Central Florida
Consortium Research Fellows Program

Donald R. Lampton
U.S. Army Research Institute

Glenn A. Martin
University of Central Florida Institute for Simulation and Training

James P. Bliss
Old Dominion University

Simulator Systems Research Unit
Stephen L. Goldberg, Chief

U.S. Army Research Institute for the Behavioral and Social Sciences
2511 Jefferson Davis Highway, Arlington, VA 22202-3926

June 2004

Army Project Number
20262785A790

Personnel Performance and Training Technology

Approved for public release; distribution is unlimited.
FOREWORD

Emerging Virtual Environment (VE) technologies, such as low cost computer image generators, intelligent computer-controlled forces, and immersive displays, have the potential to provide training, mission rehearsal, and experimentation capabilities for dismounted Soldiers and leaders. Virtual simulation can provide a means for dismounted leaders, Soldiers, and units to train effectively over a wide range of conditions. The same technologies also can be used for development of new Infantry concepts and doctrine, and applied to development of mission planning and rehearsal tools. The capability to use effective virtual simulations for dismounted combatants has implications for training of today’s dismounted leaders and Soldiers, and for the development of effective Future Force concepts and systems.

As part of a research program to enhance VE training capabilities for dismounted Soldiers, ARI developed the Dismounted Infantry Virtual After Action Review System (DIVAARS) to address the unique challenges and advantages of conducting After Action Reviews (AARs) of virtual exercises. DIVAARS received very positive ratings from Soldiers who participated in AARs conducted during the development of the system. During these tryouts the system was operated only by the computer scientists who programmed the system. Since they were intimately familiar with how the system worked, there was no need to produce a user-friendly operator’s manual. However, it became apparent that there would be a demand for DIVAARS at several different geographically dispersed research facilities, and it would not be cost effective to provide individual training for each operator. This research product was developed in response to this need for training.

DIVAARS has been delivered and installed at the Soldier Battle Lab, Fort Benning GA in September, 2003. In addition, the system is being used in three ongoing SBIR Phase II efforts. DIVAARS will also serve as the AAR system for the Virtual Integrated MOUT Training System demonstration that is scheduled to be installed at Fort Campbell KY.

[Signature]

STEPHEN L. GOLDBERG
Acting Technical Director
User Manual for the Dismounted Infantry Virtual After Action Review System (DIVAARS)

CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Procedure</td>
<td>3</td>
</tr>
<tr>
<td>Results</td>
<td>3</td>
</tr>
<tr>
<td>References</td>
<td>7</td>
</tr>
<tr>
<td>Appendix A. DIVAARS User Manual</td>
<td>A-i</td>
</tr>
</tbody>
</table>
Introduction

The Dismounted Infantry Virtual After Action Review System (DIVAARS) is an after action review system designed specifically for use with infantry exercises conducted in virtual environments. DIVAARS was developed as part of a program of research to develop virtual environment training systems for small infantry units such as fire teams, squads, and platoons.

A spiral development process was used to develop DIVAARS. It included several iterations of software development, testing and interviews with Soldiers to evaluate existing capabilities and identification of desired enhancements, and then further development. The functionality, hardware, and software aspects of DIVAARS are described in detail in Knerr, Lampton, Martin, Washburn, and Cope (2002). Soldier ratings of the DIVAARS system are presented in Knerr and Lampton (2003).

During the development of DIVAARS, the system was operated only by the computer scientists who programmed the system. These individuals were intimately familiar with how the system worked. Therefore, there was no need to produce a user-friendly operator’s manual. However, it became apparent that there would be a demand for DIVAARS at several different geographically dispersed facilities. The DIVAARS operators at those facilities could not be expected to be familiar with operating the system, and it would not be cost effective to provide individual training for each operator. This research product was developed in response to this need for training.

The DIVAARS User Manual has been designed to provide stand-alone training concerning the operation of the DIVAARS software. The following is a description of the methods used to design the layout and content of the DIVAARS User Manual.

The manual was written to be useful for both novices (as an introduction to the software) and experts of DIVAARS (who would use the manual as a reference tool), based on some basic principles in user manual design (Bremer, 1999). To design the manual as a stand-alone training guide, some compromises had to be made in the manual’s style, pertaining to the target audience. More computer literate readers may prefer less detailed instructions. However, to provide sufficient information to the average reader, who will most likely be unfamiliar with the DIVAARS software, the instructions have been written in step-by-step detail. Experienced users of the system may find the manual useful as a reference for the various advanced features DIVAARS has to offer.

Initial challenges of designing the user manual were identifying and prioritizing (by frequency of use) the various features available. Those features identified as fundamental to the operation of DIVAARS were given precedence. They are described more comprehensively in the manual, and are presented ahead of optional or advanced features. Some of the basic features include loading and saving scenarios and data files, describing the DIVAARS playback controls, and explaining the various viewpoint modes. Features that are more advanced, but often used, include the environmental
controls (e.g. fog and time of day), saving viewpoints and events, and accessing statistical data in the form of tables and graphs. Furthermore, many features work in combination with other features; these are described as advanced or optional features. The Table of Contents was designed with this hierarchy in mind, presenting the Basic menu first, and the infrequently used Options and Windows menus last.

The authors of the manual collaborated with the DIVAARS software programmers at the University of Central Florida Institute for Simulation and Training (IST) to ensure an accurate description of the system’s functionality. Periodically, minor alterations to the system warranted changes in the manual during its development.

After the basic descriptions had been written, a user-test of the manual was designed and implemented by research teams at the Army Research Institute and at Old Dominion University to assess the integrity of the manual as a useful stand-alone instructional guide for the DIVAARS software.

User-tasks and questionnaires were developed to test the readability and learnability of the user manual. The Flesch-Kincaid formula was used to test general readability of the writing style. As shown in Figure 1, the Flesch-Kincaid rating for the DIVAARS User Manual is 8.4 (between 8th and 9th grade reading levels). This is typical for technical documentation (Timms, 2003).

<table>
<thead>
<tr>
<th>Readability Statistics</th>
<th><img src="image" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Readability</strong></td>
<td></td>
</tr>
<tr>
<td>Passive Sentences</td>
<td>14%</td>
</tr>
<tr>
<td>Flesch Reading Ease</td>
<td>61.8</td>
</tr>
<tr>
<td>Flesch-Kincaid Grade Level</td>
<td>8.4</td>
</tr>
</tbody>
</table>

Figure 1. Readability statistics of the DIVAARS User Manual (from Microsoft Word).

Learnability and memorability measures were used to assess how effectively the written instructions promoted successful operation of the DIVAARS features by a novice. A system has good learnability if a novice can easily learn to use its functionality. A system has good memorability if a user can learn to use it and return to it later, without having to relearn how to use it each time. User testing questions asked participants to complete complex tasks which required them to think critically about how to achieve the goal state by combining skills from previous test tasks.
Procedure

Based on Jakob Nielsen’s (1993) heuristic principles of design for usability, an expert evaluation of the manual was performed to uncover any instances of incongruity with the DIVAARS software, lack of feedback in the instructions (i.e., inadequate explanations for expected system responses), and unclear or difficult-to-understand language or illustrations.

Twenty-four (see Table 1) user-testing tasks and a brief follow-up questionnaire were designed to further investigate the findings of the heuristic evaluation. The user-testing tasks were used to test those features of the system that were anticipated to be used most often. Once finalized and revised through a pilot test, the usability test for the manual was administered to three participants, representing prospective users of the DIVAARS software. Each participant performed the user-testing tasks under direct observation by the experimenter, who recorded data for time to complete each task and number of errors made. Participants were required to use a think aloud protocol while performing user-testing tasks (Rubin, 1994; Nielsen, 1993). Thus, as participants worked on tasks, they were asked to mention anything that came to mind such as likes or dislikes they had for the system, and any confusion they experienced as a result of discrepancies between the manual description and the software interface. The experimenter observed and recorded these comments for further analysis.

Finally, user satisfaction of the DIVAARS User Manual was evaluated by a post-test questionnaire in which participants used a 5-point Likert scale to rate various aspects of the manual, and to answer some open-ended questions about their overall assessment of the manual. Additionally, comments made by participants during the think aloud user-testing protocol were assessed to determine the participants’ general attitude (positive or negative) toward the manual.

Results

Table 1 presents the number of errors observed for each task. During the testing, participants uncovered a number of imperfections in the content of the DIVAARS User Manual, and suggested ways to improve feedback to the reader. One such example—which was unanimous—was the suggestion to add screen shots and graphics to depict where certain controls and status information are located on the screen. Each participant uncovered an average of ten flaws, for a total of 29. Many were common across participants, suggesting a need to modify those aspects of the manual. Each participant was shown a revised version of the user manual once changes were implemented. Participants favored the revisions.
Table 1
Results from user-testing tasks.

<table>
<thead>
<tr>
<th>Task</th>
<th>Number of Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. What is the total time duration of this exercise? (Participant should verbally answer)</td>
<td>0</td>
</tr>
<tr>
<td>2. Use the entity Tracks in Top-down view to determine where most of the activity took place in this exercise. Note that in this version of the software, Tracks is called “Tracer”. (Participant should verbally answer and show on screen)</td>
<td>2</td>
</tr>
<tr>
<td>3. Fly in on the area you just mentioned had the most activity.</td>
<td>0</td>
</tr>
<tr>
<td>4. Fly over to the water tower and position your view as if you have “landed” on top of it. Face the row of blue townhouses.</td>
<td>1</td>
</tr>
<tr>
<td>5. Add a Preset View from this viewpoint and name it Water Tower.</td>
<td>1</td>
</tr>
<tr>
<td>6. Fly off the water tower, and reposition yourself so you are looking at it. Next, Zoom in on the water tower, using the Orbiting Fly mode.</td>
<td>2</td>
</tr>
<tr>
<td>7. Fly over to the blue townhouses.</td>
<td>1</td>
</tr>
<tr>
<td>8. Deconstruct one of the townhouses down to the 1st floor.</td>
<td>3</td>
</tr>
<tr>
<td>9. Move the elapsed time slider to about 8min, 15sec. At approximately 8min, 30sec. Tag an Event and label it Event 1.</td>
<td>2</td>
</tr>
<tr>
<td>10. Find an entity around the area. What is his ID number?</td>
<td>1</td>
</tr>
<tr>
<td>11. Without using any top menu or control panel buttons, use your mouse to switch to that entity's viewpoint.</td>
<td>1</td>
</tr>
<tr>
<td>12. Add a Preset View from the entity's view saving it as the Entity's ID name.</td>
<td>0</td>
</tr>
</tbody>
</table>
Table 1  
Results from user-testing tasks, continued.

<table>
<thead>
<tr>
<th>Task</th>
<th>Number of Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>13. Pause the scenario and Step Back to approximately 7min 30sec.</td>
<td>1</td>
</tr>
<tr>
<td>14. Toggle the Fog off.</td>
<td>2</td>
</tr>
<tr>
<td>15. Add Fog to this scene, so that visibility is set at 300. Make sure Fog is enabled. Note that the labeling of the Fog slider may differ from the manual slightly. Still set it at 300.</td>
<td>0</td>
</tr>
<tr>
<td>16. Jump to the Entity Viewpoint you saved as a Preset View.</td>
<td>1</td>
</tr>
<tr>
<td>17. Jump to Event 1 (at 8min 30sec).</td>
<td>1</td>
</tr>
<tr>
<td>18. Change the viewpoint to Flying mode. Find the entity you previously selected and follow him using Entity Top-down mode. Zoom in 1000%.</td>
<td>2</td>
</tr>
<tr>
<td>19. Change the view to Top Down. Change Zoom to 100%. While in Top Down mode, scroll the view left, right, up, and down.</td>
<td>0</td>
</tr>
<tr>
<td>20. Return to Event 1. Next, Use the Step Backward control to go approximately 15 seconds back in time. Press Play when finished.</td>
<td>0</td>
</tr>
<tr>
<td>21. Using the Entity List (called Entity Tree in manual), change to Entity View of the ATL.</td>
<td>1</td>
</tr>
<tr>
<td>22. Use the Top Down View and Zoom in 300% on the water tower. Position the view so the water tower is at about the center of the screen.</td>
<td>0</td>
</tr>
<tr>
<td>23. Return to Event 2 and the last selected Entity View (for ATL), and with the scenario Paused, Step Backward 20 seconds, then Playback the scenario in slow motion (at ½ normal speed) to see who killed the OPFOR.</td>
<td>1</td>
</tr>
<tr>
<td>24. Please Reset the scenario &amp; Exit DIVAARS using the top menus (do not click the X).</td>
<td>2</td>
</tr>
<tr>
<td><strong>Total Number of Errors</strong></td>
<td><strong>25</strong></td>
</tr>
</tbody>
</table>
Satisfaction ratings, based on the post-testing questionnaire and the think aloud comments recorded by the experimenter (see Table 2), indicated that the manual was very readable and offered a good layout and appearance. Participants also liked the table of contents and the order in which information was presented. Learnability of the manual received the lowest rating—"Somewhat satisfied"—of the satisfaction questions. Participant comments revealed some of the reasons participants found it difficult to learn the system based on the manual. All of these concerns received attention, and the manual was revised to strengthen the learnability of the system. The most challenging aspect of the software itself—recognized also by the software programmers—is learning to use the Flying controls, as evidenced by all three participants' comments. Flying controls take some practice to master. The manual illustrates the various mouse controls and movements available in each Flying mode.

Table 2
Results from the Post-Questionnaire.

<table>
<thead>
<tr>
<th>Question</th>
<th>P1</th>
<th>P2</th>
<th>P3</th>
<th>Mean</th>
<th>SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. How user-friendly did you find the DIVAARS manual</td>
<td>4.0</td>
<td>3.0</td>
<td>3.0</td>
<td>3.3</td>
<td>0.6</td>
</tr>
</tbody>
</table>

Rate your satisfaction level of the following aspects of the DIVAARS manual

<table>
<thead>
<tr>
<th>Question</th>
<th>P1</th>
<th>P2</th>
<th>P3</th>
<th>Mean</th>
<th>SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Readability</td>
<td>4.0</td>
<td>4.0</td>
<td>4.0</td>
<td>4.0</td>
<td>0.0</td>
</tr>
<tr>
<td>3. Learnability</td>
<td>4.0</td>
<td>3.0</td>
<td>2.0</td>
<td>3.0</td>
<td>1.0</td>
</tr>
<tr>
<td>4. Layout, Formatting, &amp; Appearance</td>
<td>5.0</td>
<td>4.0</td>
<td>4.0</td>
<td>4.3</td>
<td>0.6</td>
</tr>
<tr>
<td>5. Table of Contents (layout/format)</td>
<td>5.0</td>
<td>4.0</td>
<td>4.0</td>
<td>4.3</td>
<td>0.6</td>
</tr>
<tr>
<td>6. Sequence of information presented</td>
<td>5.0</td>
<td>4.0</td>
<td>4.0</td>
<td>4.3</td>
<td>0.6</td>
</tr>
</tbody>
</table>

N = 3. Responses were based on a 5-point Likert scale (1 = Very Dissatisfied, 2 = Dissatisfied, 3 = Somewhat Satisfied, 4 = Satisfied, and 5 = Very Satisfied).

On average, participants completed each user-testing task in less than two minutes. Average reading time for the manual (before using it during testing) was 21.7 minutes.

Boone et al. (2003) conducted subsequent usability tests of the DIVAARS system and manual with similar results. Eight U.S. Army officers and eight ROTC students tested DIVAARS and the manual as part of the initial phase of a long term project to develop measures of, and ways to enhance, the effectiveness of the after action review process. Findings were used to revise the current manual and will guide future enhancements of the DIVAARS software.

The DIVAARS manual was put to yet another test when DIVAARS was installed at the Soldier Battle Laboratory at Fort Benning, GA. The DIVAARS software training was centered on the manual. The manual and software were both well-received, as the three DIVAARS operator trainees found the manual to be very helpful.
References


Appendix A

DIVAARS User Manual

Bryan R. Clark
Donald R. Lampton

US Army Research Institute

Version 1.0
2004

U.S. Army Research Institute
for the Behavioral and Social Sciences
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Introduction</td>
<td>1</td>
</tr>
<tr>
<td>1.1 DIVAARS Overview</td>
<td>1</td>
</tr>
<tr>
<td>1.2 Using this Manual</td>
<td>1</td>
</tr>
<tr>
<td>2. About the System</td>
<td>3</td>
</tr>
<tr>
<td>2.1 System Requirements</td>
<td>3</td>
</tr>
<tr>
<td>2.2 List of DIVAARS Features</td>
<td>3</td>
</tr>
<tr>
<td>3. Using the System</td>
<td>4</td>
</tr>
<tr>
<td>3.1 System Startup</td>
<td>4</td>
</tr>
<tr>
<td>3.1.1 Loading a Scenario</td>
<td>4</td>
</tr>
<tr>
<td>3.1.2 Loading Captured Data</td>
<td>4</td>
</tr>
<tr>
<td>3.2 System Shutdown</td>
<td>4</td>
</tr>
<tr>
<td>4. Basic Functions of AAR mode</td>
<td>5</td>
</tr>
<tr>
<td>4.1 Playback Controls</td>
<td>5</td>
</tr>
<tr>
<td>4.2 Elapsed Time Scrollbar</td>
<td>6</td>
</tr>
<tr>
<td>4.3 Views Menu</td>
<td>6</td>
</tr>
<tr>
<td>4.3.1 Entity View</td>
<td>6</td>
</tr>
<tr>
<td>4.3.2 Entity Top-down</td>
<td>7</td>
</tr>
<tr>
<td>4.3.3 Top-down</td>
<td>7</td>
</tr>
<tr>
<td>4.3.4 2D View</td>
<td>7</td>
</tr>
<tr>
<td>4.3.5 Flying/Orbiting</td>
<td>7</td>
</tr>
<tr>
<td>4.3.5.a. Flying Mode</td>
<td>8</td>
</tr>
<tr>
<td>4.3.5.b. Orbiting Mode</td>
<td>8</td>
</tr>
<tr>
<td>4.3.6 Preset Views</td>
<td>9</td>
</tr>
<tr>
<td>4.3.7 Take Picture</td>
<td>9</td>
</tr>
<tr>
<td>4.4 Events Menu</td>
<td>9</td>
</tr>
<tr>
<td>4.5 Buildings</td>
<td>11</td>
</tr>
<tr>
<td>5. Options Menu</td>
<td>12</td>
</tr>
<tr>
<td>(Fog, Entity ID Markings, Time of Day, Tracks, Wireframe, Sound, Voice, Flying, Script)</td>
<td></td>
</tr>
<tr>
<td>6. Window Menu</td>
<td>13</td>
</tr>
<tr>
<td>6.1 Tables and Graphs</td>
<td>13</td>
</tr>
<tr>
<td>6.2 Entity List</td>
<td>14</td>
</tr>
<tr>
<td>6.3 Open/Close Second Window</td>
<td>14</td>
</tr>
<tr>
<td>7. Special Effects</td>
<td>14</td>
</tr>
<tr>
<td>(Bullet Lines, Smoke and Grenades, Street Lamps, Dynamic Terrain)</td>
<td></td>
</tr>
<tr>
<td>8. Glossary Terms and Troubleshooting</td>
<td>16</td>
</tr>
</tbody>
</table>
1. Introduction

1.1 DIVAARS Overview

The Dismounted Infantry Virtual After Action Review System (DIVAARS) supports AARs for dismounted infantry exercises conducted in virtual environments. The AAR Leader uses DIVAARS to observe an exercise, and then to conduct an AAR with the unit that will lead them to an understanding of what and why events unfolded, and how to improve performance.

Before an exercise, DIVAARS allows the AAR Leader to preview the virtual environment in which the mission will be conducted. Locations and angles expected to provide the best views of the action can be selected and stored for rapid access during the exercise and during the AAR.

During the exercise, DIVAARS provides several flexible modes for viewing the action and for tagging key events. Tagging captures the exact time of an event and provides the option of entering a label or brief note for an event.

During the AAR, DVD-like controls enable a flexible and efficient replay of key segments of the exercise. In addition to a practically unlimited number of viewing positions and angles, DIVAARS can replay mission action exactly as viewed by any of the participants, including the Opposing Force. Thus, each unit member can observe the location, posture, and actions of all the other unit members. In addition, special graphics enhance the depiction of movement and firing events. These features not only support the trainees' understanding of why events happened, but also help the unit members develop shared mental models of individual and unit tasks. Watching the replay may also strengthen group identification and cohesion.

1.2 Using this Manual

To get the most out of this manual, read through it once, then load a scenario and try to use some of the features described in the manual. If you get stuck, you can always refer back to the information. It may be useful to skim over the Glossary Terms on the last page of this manual, to become familiar with some of the DIVAARS terminology.

The sections you should focus on are: Views, Events, and Playback Controls. The Views menu has many features, and Flying may take the most time to master. The Events menu allows you to log the time of an event in a scenario, and works along with Views and Playback. The Playback Controls are also very useful, especially when switching viewpoints, returning to events, or changing the speed of playback.
Figure 1 Control panel and functions map.
2. About the System

2.1 System Requirements

**Hardware**
- Pentium 4, 2.0 GHz (or equivalent)
- 512 MB RAM
- Hardware-accelerated video card
  - (nVidia preferred)
  - (with dual monitor outputs if AAR is to be presented via a projector)

**Software**
- Red Hat Linux v. 9.0
- Open Scene Graph 0.9.6-2
- OpenAL (www.openal.org)
- Virtual Environment Software Sandbox v. 3.0.0 (http://vess.ist.ucf.edu/)

2.2 List of DIVAARS Features

- Flexible replay system with synchronized audio
- Multiple viewing modes
- Movement tracks
- Individual identifiers
- Dynamic terrain
- Building de-construction (to view inside buildings)
- Weapons (bullet lines, smoke, grenades)
- Environmental effects (fog, time of day)
- Tabular & graphic data presentation
- AAR and stealth viewing modes
3. Using the System

3.1 System Startup

1. Open the terminal window (click the icon of the computer monitor in the bottom toolbar on your screen)

2. In the terminal window type: cd aar/bin (must be in lowercase) and press Enter

3. Next, type: divaar (must be in lowercase) and press Enter

3.1.1 Loading a Scenario

A Scenario is the database defining the location of buildings, roads, trees, etc.

- If the scenario window is not already on your screen, go to the top menu, click on File, and select Open Scenario. Choose a scenario file, making sure the file name ends in .scn
- The name of the scenario will appear at the bottom of the screen, once loaded.

3.1.2 Loading Captured Data

Captured Data defines the location and condition of each entity as a function of time over the course of the entire exercise.

- Click on File and select Load Captured Data. Choose the data file you wish to view, and make sure the file name ends in .pdu
- The name of the captured data file will appear at the bottom of the screen.

3.2 System Shutdown

- Click on File and select Quit
4. Basic Functions of AAR mode

4.1 Playback Controls

The playback controls (depicted below) are similar to that of a DVD player. You will find buttons for Play, Pause, Rewind, Fast-forward, and Stop.

<table>
<thead>
<tr>
<th>Capture/Playback Controls</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rewind</td>
</tr>
</tbody>
</table>

**Rewind**
Reverses playback at 15 times normal speed.

**Reverse**
Reverses playback. May be used with Speed adjuster to right of panel.

**Step Back**
Active when scenario is *Paused*. Steps back in time by 5-second increments.

**Pause**
Pauses playback of the scenario.

**Step Ahead**
Active when scenario is *Paused*. Steps ahead in time by 5-second increments.

**Play**
Normal playback. Speed may be adjusted with the Speed adjuster at right.
Normal playback speed = 1.00.

**Fast Forward**
Fast-forwards the scenario at a speed of 15 times normal playback.

**Stop**
This *RESETS* the entire scenario. Use *Pause* to temporarily stop playback.

**Record**
Not used in Playback mode (button is grayed out).

**Speed** (to right of Record button)
Adjusts the speed of playback for Play and Reverse. Use the up/down arrows or enter a number between .25 and 10.00. Normal playback speed is 1.00
4.2 Elapsed Time Scrollbar

At the bottom of the DIVAARS window, you will find a horizontal scrollbar. To the left of the scrollbar is the start-time (zero), and to the right is the total length of time for the captured data file. The elapsed time is shown at the top right of the screen, next to Tag Event. You can move the slider on the scrollbar to go to any point in time within the scenario. Moving it all the way to the end (right) is useful to use along with entity Tracks feature (Section 5, p.12) to see where most activity took place during the scenario. Once you have moved the slider, please wait a moment for the software to process the changes. You will need to press the Play button (see Playback Controls, p.5) to continue playback of the scenario.

4.3 Views Menu

The scenario can be viewed from many perspectives, such as 1st person (entity) and 3rd person (whole scenario) points of view. Each view is listed here with shortcut keys in parenthesis next to the name of the view mode. Some views require use of the keyboard and/or mouse to control them, as described below.

Zoom
Some views allow zooming; in this manual, a magnifying glass (Zoom) appears below their names. To Zoom, use the up and down arrow buttons in the Zoom control box (below the Play button), or enter a number between 5 and 1600%. The default is 100%.

4.3.1 Entity View

This allows you to view the scenario through the eyes of any entity.

→ There are three (3) ways to select an entity:
1. Click and hold the right mouse button with the cursor positioned on any entity in the scenario and choose Goto Entity View from the menu. (Entity Selected is displayed in bottom left of screen when Playback is Paused).

2. Click on the top menu, Window then Entity Tree. From the Entity Tree window, use your mouse to click once on the name of the entity you want. Next, go to the View menu at the top of the screen, and choose Entity View.

3. Click on the Entity View button to return to the last entity that was selected.

NOTE: You must select an entity using method 1, prior to using this option.
4.3.2 Entity Top-down

- This is similar to the other top-down views, except that it follows the entity you’ve selected.

→ Click the **Entity Top-down** button to go to the currently selected entity.

4.3.3 Top-down

- View the scenario from a top-down 3D viewpoint.

→ Press the **Top-down** button. Click your left mouse button anywhere below the control panel, and use the arrow buttons on your keyboard to move around.

4.3.4 2D View

- View the scenario from a top-down 2D viewpoint.

→ Select **2D View** from the **View** menu.

4.3.5 Flying/Orbiting (Ctrl+F)

- This allows you to “fly” around the scenario and stop at any point to watch the scenario from a 3rd person point of view. There are two fly modes, **Flying** and **Orbiting**.

→ Press the **Flying/Orbiting** button.

Flying in the DIVAARS requires use of the keyboard and mouse simultaneously.

It is important to master both types of flying, and to use them together in order to maximize your ability to maneuver in a scenario. Each fly mode has unique features: **Flying** is good for moving to a general area. **Orbiting** fly mode allows you orient yourself around, and precisely zoom in on a target. The diagrams below illustrate the mouse button controls mapped to their functions in each fly mode.
4.3.5a Flying Mode

The SHIFT key is like the on/off switch. You must hold it down to move. While you hold it down, you can use the mouse to move left / right or up / down, and your view will move in the respective direction. Use the mouse buttons to move forward or backward.

Note: the more times you press a particular mouse button, the more you'll accelerate. The middle button can be thought of as the brakes—pressing it will immediately stop you.

Hold down \[ \text{\textbf{Shift}} \] and \textbf{Press} a mouse button (one click)

Left = FORWARD  Middle = STOP  Right = BACKWARD

4.3.5b Orbiting Mode

Orbiting is similar to Normal fly mode, with these exceptions. Orbiting allows you to center yourself around an object, circle it, and zoom in/out. Unlike Normal fly mode, you must first center your mouse cursor on the object or area of the scenario that you would like to orbit. Instead of holding the Shift key, hold down the CTRL key.

See the diagram below for button controls.

Hold down \[ \text{\textbf{Ctrl}} \] and \textbf{Press and hold} a mouse button

Left = ORIENT / ORBIT  Right = ZOOM

(move mouse up/down or right/left)

Look at Sky  Zoom Out = Push mouse away from you

Look at Ground

Zoom In = Pull mouse toward you
4.3.6 Preset Views

Add/Delete Preset Views

From any Top-down or Fly mode, you can select a viewpoint you'd like to save and return to later. For example, you may wish to view the scenario from the roof of a specific building or from any location on the ground. Preset Views allow you to quickly jump to a viewpoint.

→ Position your screen at the desired viewpoint.
Select Add/Delete Preset Views from the View menu.
Name the Viewpoint and select Save, to save the new viewpoint. You can also select Delete to delete a viewpoint you have previously saved.
To cancel, select Close.

Return to a Preset View

→ To return to a preset view, simply click on the Select a Preset View button on the control panel, and select the name of the viewpoint you want to return to.

4.3.7 Take Picture

Capture screen shot.

→ Select Take Picture from the View menu to capture the current screen shot. You can then name and save the picture on your computer.

Select View Picture from the View menu to view previously saved screen shots.

4.4 Events Menu

An Event works similarly to a Preset View. You can tag a specific point in time, and name it for later reference. Currently, Event does not allow you to store a view with the time itself, but the next version of DIVAARS will allow this.

Saving (Tagging) an Event
There are 2 ways to Tag (or save) an Event in Stealth mode (live) or during playback, based on the nature of the event.

NOTE: There is no need to Pause playback to Tag an Event.

1) To tag a Single Instance event (an event not expected to repeat):

1. Click the Tag Event button, and a small Tag Event window (see Figure 2) will open displaying the time to be tagged, and a field where you can label the
event with a descriptive name. Enter the event name and click **Save** to store the time of the event.

2) To tag a **Type** of event (an event that may repeat):
Prepare for anticipated types of event (e.g., a fratricide) before using DIVAARS in Stealth mode to watch a live training session, or before playback during an AAR.

1. Click on the top **Events** menu, and select **Add/Delete Preset Event Names**.
2. A small window will appear where you can add or delete event names.
   - To **Add** a new event name, type in the name and click **Save**.
   - To **Delete** an existing event name, highlight the name in the left-hand box, and click **Delete**.
3. To tag the event during playback, click the **Tag Event** button, and a small **Tag Event** window will open (see Figure 2) displaying the time to be tagged. Select the event type from the drop-down box and clicking **Save** to store the time of the event.

**Returning to an Event**
Once an event has been tagged using either of the methods above, you can return to the event **time** by selecting the event name (and time) from the **Jump to Event** drop-down menu (next to the **Tag Event** button). The event time is provided next to the event type/name so that you can easily determine which event you want to return to in case there are duplicate event names stored in a single scenario (such as in the case of a type of event).

**NOTE:** When returning to an Event, the elapsed time displayed will be 5 seconds prior to the Tagged time. This allows you to watch the action leading to the event.

![Tag Event window](image)

**Figure 2.** Tag Event window.
4.5 Buildings

DIVAARS allows you to see inside all building structures, (i.e., houses, water towers, etc.) at any specific floor/level. Simply **click and hold the right mouse button** while the cursor is positioned on the building you want. Next, choose the floor you wish to view, from the list of available floors in the building. (If there is a basement, it will be labeled *Floor 1*). Once you choose a specific floor, the building can be viewed from any angle, as if there is no roof, nor floors above it. If there are entities on floors above or below the floor you choose to view, they will not be visible, unless they move to that floor.

You may wish to use *Add Preset View* with the building deconstruction feature. However, be aware that when you store a preset view, you do not store the condition of the building. If you wish to view the 3rd floor of a building, for instance, you must still click and hold the right mouse button while the cursor is positioned on the building, but *Add Preset View* can store the angle you wish to view it from.

![Figure 3. Selecting the floor of a building to view.](image-url)
5. Options Menu

At the top of the screen you will find a drop down menu titled Options. This menu is used to toggle several of the advanced features on and off, to change the default flying mode, and to play or record a system demonstration. The options menu includes:

(+)

- Fog
- Markings (Entity ID)
- Time of Day
- Tracks
- Wireframe
- Sounds
- Voice
- Flying Motion (+)
- Script (for system demo) (+)

Fog
On the right hand side of the control panel is a slider button for Fog Visibility Distance. The leftmost setting is Zero Visibility, or the most fog; the right-most setting is 5000 meters, or No Fog. Clicking the left mouse button to the right or left of the slider will gradually change the amount of Fog/Visibility in increments of 10 units. Use the right and left arrow keys on the keyboard to change fog setting in increments of one unit. If you wish to disable the slider button, click on Fog in the Options menu to remove the checkmark; the slider control will appear grayed out.

Markings (Entity ID)
To identify the entities in a scenario, Markings may be used to toggle on/off the entity identification labels above their heads. For example, 2SL would indicate the leader of the second squad. Sometimes you may not want these markings visible; simply remove the checkmark next to Markings in the Options menu to disable them.

Time of Day
On the control panel there is a slider button that works a lot like the Fog button described above. (The default time setting is defined in the scenario.scn file). Moving the slider left and right will change the time of day, as indicated below the button, and the environment will change to reflect this (day vs. night). Clicking the left mouse button to the right or left of the slider will gradually change the time of day in increments of 10 units. Use the right and left arrow keys on the keyboard to change the time of day setting in increments of one unit. When Time of Day is disabled, by removing the checkmark next to Time of Day in the Options menu, the slider button will be grayed out. When toggled back On, it will return to the previous time setting.

Tracks
To see a footprint trail of where each entity has been, click Tracks in the Options menu. A checkmark will appear next to Tracks to show it is enabled, and various colored tracks will appear on the screen to show the entities’ paths. A good way to find out where most
of the action of a scenario took place is to move the elapsed time slider at the bottom of the screen, all the way to the right, and then turn the Tracks on.

**Wireframe**
This toggles wireframe view on/off, allowing you to see through all non-entity objects.

**Sound**
This toggles the sound on/off for Sound Effects, such as gunshots, explosions, etc.

**Voice**
This toggles Voice sound on/off, such as radio communications recorded in a scenario.

**Flying Motion (+)**
You can choose between two flying modes. **New** does not display a mouse pointer and uses the left/right motion of the mouse as a direct yaw manipulation. **Original** shows the mouse pointer and uses the left/right mouse motion as an indirect (velocity) yaw manipulation. Both methods use the up/down motion as a direct pitch manipulation.

**Script (+)**
This is used to Play/Pause, Stop, and Record a scenario to be used in a repeating looped playback; good for demonstrating the functionality of the DIVAARS.

### 6. Window Menu

#### 6.1 Show Tables and Show Graphs

There are various Tables and Graphs of scenario statistics available. Click the top menu **Windows**, then **Show Tables and Graphs**, and a new window will open. Next, use the drop-down menu at the bottom of the new window to select the table or graph you wish to view. Below is a list of tables and graphs available, along with a brief description:

1. **Rounds Fired by Time** (divided into 25 equal periods – in seconds)
2. **Total Rounds Fired** (total number, hierarchical by team and members)
3. **Kills Inflicted by Time** (seconds)
4. **Killer/Victim** (who killed who, and posture)
5. **Killer Range** (meters)
6. **Total Kills Inflicted** (total number, hierarchical by team and members)
7. **Movement Rates** (% movement and time stationary)
8. **Posture** (% time standing, kneeling, or prone, and # posture changes; hierarchical by team and members)

**Note:** Some of the table/graph data regarding an event (such as a "kill") may not be available until the elapsed time scrollbar has reached the time of the event. Move the scrollbar (see Section 4.2, page 6) all the way to the right to view all data for a scenario.

**Posture Overview** is an additional graph (not available as a table), which allows you to view a pie chart of a single entity’s posture data. All graphs (except Posture Overview) are color-coded according to the color of the Entity ID (see Section 5, page 12, **Markings**).
6.2 Entity List

Entity List (or Entity Tree) allows you to view a list of all entities in a captured data file. If you need to locate an entity, it is sometimes easier to use the Entity List and choose (click on) the name of the entity, then press the Entity View button (see Section 4.3.1, Entity View). This will change your viewpoint to that of the selected entity.

6.3 Open/Close Second Window

You can also Open (or Close) a Second Window if you want to operate the controls on one monitor, and show the scenario without the control panel at the top, on another monitor.

7. Special Effects

DIVAARS offers an array of special effects to enhance the scenarios. The features described in this section are:

- Bullet Lines
- Smoke
- Grenades
- Time of Day (see Section 5, page 12)
- Fog (see Section 5, page 12)
- Street Lamps
- Dynamic Terrain

**Bullet Lines**
Whenever someone fires a weapon in DIVAARS, a colored line will flash from the person to their target. This helps to see who fired at what target during an AAR.

**Smoke and Grenades**
Soldiers may use smoke grenades, which generate various colors of smoke (e.g., white, green, red, or yellow). As mentioned above, when a smoke grenade is thrown, a bullet line will flash between the person who threw it, and the point where the grenade lands. **Note:** When DIVAARS is in Pause, smoke will continue to move.

Currently, three types of grenades can be displayed in DIVAARS:

- Smoke grenades
- Flash-bang Grenades
- Fragmentation Grenades
Street Lamps
Street lamps produce a small area of light, which can be seen in a scenario when the time of day is set later than 7pm. If a street lamp is shot out during the exercise, it will no longer produce light.

Dynamic Terrain
Dynamic Terrain is the ability to display changes in the terrain database that occur during an exercise. (The Army Research Lab domain server must be running during an exercise, but not during replay.) Two examples are bullet holes and demolition charges. Both will be recreated at the appropriate time during replay.

- Rifle fire that hits walls will leave “bullet holes”—small black marks that will remain visible for the remainder of the exercise.
- A demolition charge may be used to breach a wall during an exercise. After detonation, a hole will appear large enough for troops to pass through the wall; rubble may also appear around the breach.
8. Glossary Terms and Troubleshooting

**ARI** – Army Research Institute for the Behavioral and Social Sciences

**Captured Data** – A training exercise may be recorded, or "captured", and loaded for playback at a later time. *Captured Data* refers to the data file that defines the location and condition of each entity, as a function of time, over the course of the entire exercise. (See page 4)

**Dynamic Terrain** – The ability to display changes in the terrain database that occur during an exercise. (See page 15)

**DIVAARS** – Dismounted Infantry Virtual After Action Review System (See page 1)

**Entity** – This refers to any Soldiers or townspeople in a *scenario*. (See pages 6, 12, and 14)

**IST** – Institute for Simulation and Training

**Markings** – The ID label above each *Entity's* head. (See page 12)

**Normal Fly Mode** – This *View* feature is used to "fly" around a scenario from a 3rd person point of view. Normal Fly Mode allows you to move forward, backward, and from side-to-side. (See pages 7-8)

**Orbiting Fly Mode** – This *View* feature allows you to circle around an object as well as zoom in or out with respect to the object of interest. (See pages 7-8)

**Scenario** – This refers to the database defining the location of buildings, roads, and trees. (See page 4)

---

**Troubleshooting or further assistance, please contact:**

Don Lampton        (407) 384-3989        don.lampton@peostri.army.mil